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EXECUTIVE MESSAGE 

Catena Analytics offers powerful platforms for building accessible and scalable analytical tools and 

simulation models that can be accessed via desktop or mobile devices.  Our team has spent the last 

decade developing the Environmental Resource Assessment and Management System (eRAMS), an 

open source technology that provides cloud-based geospatially-enabled software solutions as online 

services and a platform for collaboration, development, and deployment of online tools.  Our 

services are used to assist with strategic and tactical decision making for sustainable management of 

land, water and energy resources. Thank you for choosing Catena Analytics and the eRAMS platform 

to meet your data, modeling, analysis and geospatial needs.  

 

WHO SHOULD USE THIS GUIDE 

This guide is a tutorial to get you started using eRAMS and the Integrated Urban Water Model 

(IUWM). The guide provides instructions for commonly performed tasks and uses of the tool.  This 

tool is intended for use by urban planners and water managers, academic groups, regulatory officials, 

consultants as well as state, local and federal agencies planning for the future of water resources. 

 

NEED HELP? 

After reviewing the guide and video tutorials, if you need additional assistance we are here to help!  

This guide is designed to provide instruction on commonly performed operations and answers to 

many frequently asked questions. If you find any aspect of the tool challenging or missing 

information from this guide, please engage an eRAMS expert to guide you through any hurdles.  

Contact us at: eramsinfo@gmail.com   

http://onewatersolutions.com/
mailto:mowsi@colostate.edu
http://www.erams.com/iuwm
http://www.erams.com/iuwm
mailto:eramsinfo@gmail.com
mailto:eramsinfo@gmail.com
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INTRODUCTION 

PURPOSE 

To forecast urban water demand and project potential savings from conservation and use of 

alternative water sources over varying climatic conditions and land uses. 

DESCRIPTION 

The Integrated Urban Water Model (IUWM) is a high level planning tool that allows urban planners 

and water managers to consider potable water savings of indoor and outdoor conservation 

measures, and alternative water sources such as graywater, stormwater, and reclaimed water. IUWM 

primarily projects water demands and revenue for municipal water providers through a combination 

of mass balance and empirical relationships. 

The purpose of IUWM is to evaluate alternative urban water management strategies under varying 

climatic conditions at a municipal or regional scale. IUWM has been deployed as an online tool and 

as a web service, enabling accessibility, ease of use, and collaborative benefits for project teams. 

IUWM facilitates the development of urban water demand forecasts through automated retrieval of 

publicly available data inputs through a geographical information system (GIS) interface, reducing 

the need for manual input of data.  

Indoor residential demands are forecast based on end-use at the census block level with population 

and household data retrieved from the United States census. Combined residential/commercial, 

industrial, and institutional (CII) irrigation demands are forecast based on daily evapotranspiration 

and land cover data.  

The following water management strategies are included in IUWM: 

• Indoor conservation 

http://onewatersolutions.com/
mailto:mowsi@colostate.edu
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• Irrigation conservation 

• Graywater reuse for toilet flushing and irrigation 

• Stormwater capture and use 

• Roof runoff capture and use 

• Wastewater treatment plant (WWTP) effluent reuse 

• Extensible for other alternative sources 

 

SOFTWARE AVAILABILITY 

Domain 

www.erams.com/iuwm 

 

Documentation URL 

https://erams.com/catena/tools/urban-planning/urban-water-demand-forecasting/ 

  

Publication/Citation 

Sharvelle, Sybil, Andre Dozier, Mazdak Arabi, and Brad Reichel. 2017. “A Geospatially-Enabled Web 

Tool for Urban Water Demand Forecasting and Assessment of Alternative Urban Water Management 

Strategies.” Environmental Modelling & Software 97 (Supplement C): 213–28. 

https://doi.org/10.1016/j.envsoft.2017.08.009 

 

AUTHORIZED USE PERMISSION 

The information contained in the Integrated Urban Water Model (the "Service") is for general 

information purposes only.  Colorado State University’s One Water Solutions Institute (“CSU-OWSI”) 

assumes no responsibility for errors or omissions in the contents of the Service. In the Service 

(http://erams.com/iuwm), you agree to hold neither the creators of the software platform nor CSU-

OWSI liable for any action resulting from use or misuse of the Service.  In no event shall CSU-OWSI 

be liable for any special, direct, indirect, consequential, or incidental damages or any damages 

whatsoever, whether in an action of contract, negligence or other sort, arising out of or in connection 

with the use of the Service or the contents of the Service. CSU-OWSI reserves the right to make 

additions, deletions, or modification to the contents of the Service at any time without prior notice.  

  

http://onewatersolutions.com/
mailto:mowsi@colostate.edu
http://www.erams.com/iuwm
https://erams.com/catena/tools/urban-planning/urban-water-demand-forecasting/
https://doi.org/10.1016/j.envsoft.2017.08.009
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GETTING STARTED 

QUICK START 

The Integrated Urban Water Model has sophisticated graphing capabilities that allows the user to 

evaluate the impact of land use configurations, changes in climate, conservation programs and 

alternative water sources on water supply demands. The graphing tools can be tailored to the user’s 

needs and exported along with the raw model outputs.   

Follow the simple workflow below to get started: 

1. Define a geographic area 

2. Select subunit scale and datasets 

3. Create scenarios 

4. Compare and analyze results 

 

SYSTEM REQUIREMENTS 

A modern web-browser is required to connect and run IUWM.  Browser options include: Google 

Chrome v.69, Mozilla Firefox v.62, Safari v.11.1, and Microsoft Edge v.17. 

  

http://onewatersolutions.com/
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USING THE TOOL 

ACCESS THE TOOL 

Public Access 

The Integrated Urban Water Model can be accessed without registering an eRAMS account.  In the 

public-facing version the data and analysis will only be available for the duration of the browser 

session.  Once the browser is closed the project will no longer be available (i.e. users cannot save 

their work or share their project).  

If a user prefers to save their project, share it with collaborators or revisit their analysis, an account is 

required.  Follow the instructions below to create your free account and save your projects or visit 

our website to get started: https://erams.com/account/ 

Create an eRAMS Account 

1. From the eRAMS Registration page, select "Register Now" from the top menu and enter a 

username, password, your first and last name, and your email address. Click “Create 

Account”. 

• eRAMS will display a popup box alerting you that an email confirmation has been 

sent to the provided email address 

2. Open the email account provided in the registration form from either a new browser window 

or from your local email application.  

• Search for an email from eRAMS with the subject line “eRAMS Email Check” 

3. Open this email and click on the provided link to confirm your email address. 

• Note: If you do not see the confirmation email appear in your email inbox 

immediately, check your spam or junk email folder to ensure that the confirmation 

message wasn’t automatically discarded. You may also need to wait a few moments to 

ensure the email is delivered successfully. 

4. Once you click on the provided email link, you should be redirected to eRAMS, where you’ll 

be automatically logged in 

  

http://onewatersolutions.com/
mailto:mowsi@colostate.edu
http://www.erams.com/iuwm
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Registered User Access 

1. Login to your eRAMS account here: https://erams.com/account/ 

2. Select the “Projects” tab from the left panel 

• Hint: You must be logged into your eRAMS account 

3. Select “Create Project” from the top toolbar 

4. Enter a Project Name 

• Alternatively, select a project from the list to access previous projects 

5. Select “Integrated Urban Water Model” from the Project Type drop down 

• Optional: Select layers from previously saved project under the “Include Layers from 

Project” drop down 

6. Click “OK” 

7. Locate the name of the project you have created in the project list, click the link 

• The link will redirect you to the IUWM interface where you can conduct analysis and 

save your work to your account 

  

Figure 1: Registered user process for creating an IUWM project in eRAMS 

http://onewatersolutions.com/
mailto:mowsi@colostate.edu
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STEP 1 - DEFINE A GEOGRAPHIC AREA 

Select Base Layer 

With the IUWM interface open, click the “Map” tab on the left dashboard 

1. Select the “Base Layers”  drop-down 

2. Select the desired base layer 

• Options include: None , Google, Bing or USGS National Map 

 

Define Service Area 

With the IUWM interface open, click the “IUWM” tab on the left dashboard.  Create or select your 

service area by performing one of the following operations: 

Draw Service Area 

The options for manual selection of the geographic region of interest (i.e. service area) include the 

area within a desired radius of a point (point buffer); area within a buffer of a line; area within a 

rectangle; or area within a free-hand polygon. 

1. Select boundary type 

• Enter desired buffer radius (point or line) 

2. Place point(s) on desired map location 

3. Name the service area 

 

Select Known Boundary 

Users can select a region from known boundaries such as states, counties, or hydrological unit codes 

(HUCs). 

1. Select “Known Boundary” 

2. Select predefined boundary from drop down list(s) 

 

Upload Boundary Layer  

Users can upload a layer (shapefile) by performing the following operations: 

1. Select “Upload a Boundary” 

2. Select a shapefile for upload from your device 

• All files associated with a shapefile can be zipped into a ZIP archive (*.zip) then 

uploaded, or multiple files can be uploaded at the same time outside of a ZIP archive 

• Depending on the size of your file(s), it may take a few minutes to process 

 

STEP 2 - SELECT SUBUNIT SCALE & DATASETS 

http://onewatersolutions.com/
mailto:mowsi@colostate.edu
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Subunits and datasets are prepopulated for each of the categories below.  However, users are able to 

upload their own files for analysis as described below. Once the subunits and datasets have been 

selected click “Generate” to process the data for each subunit in the analysis (it may take a few 

minutes to process). 

Upload Files 

Users can upload files (Fig. 2) for subunits and data sets as described in each section.  There are three 

ways you can add your own information under the “Map” tab: 

(i) Geospatial Layers – Public facing access for uploading files 

(ii) Project Layers – Registered user access, these files correspond to the current project and will 

be available to any members of the project (i.e. used within a project).  Check out the eRAMS 

Grouping capabilities for more information about sharing projects.   

(iii) User Layers – Registered user access, these files are associated with your user account and 

can be accessed from any project (i.e. used across projects) 

 

 

 

Select Subunit Scale 

IUWM forecasts municipal potable water demand for each subunit. These subunits can be selected 

from nationally available polygon databases such as US Census Counties, Tracts, Block Groups, or 

Blocks, or they can be defined using a user uploaded polygon shapefile. 

Figure 2: Adding Layers - public access pictured left, registered user access pictured right 

http://onewatersolutions.com/
mailto:mowsi@colostate.edu
https://erams.com/documentation/erams-groups/
https://erams.com/documentation/erams-groups/
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1. Select either a National Dataset or Upload a layer 

• Layers can be uploaded under the “Map” tab (Fig. 3)  > Geospatial Layers (Public) or 

User Layers/Project Layers (Registered User) > Click “Spatial Layers” > Add Layer > 

Select Layer Type > Select File > Click “OK” 

 

Select Datasets 

The eRAMS platform retrieves live data for each of the databases listed below.  Thus, the processing 

time may take a few minutes after you have selected “Generate” to complete the extraction. 

Population 

US Census 2000 and 2010 population and demographic data at Block, Block Group, and Tract levels 

are available as options for the US National Datasets drop-down menu. However, any user provided 

layer as a polygon feature class (i.e., shapefile) can be used to estimate population, demographics, 

and housing units for each subunit.   

• IUWM defaults to US Census Block 2010, but users can modify by selecting from the drop 

down menus or upload a shapefile 

• Layers can be uploaded under the “Map” tab  (Fig. 3) > Geospatial Layers (Public) or User 

Layers/Project Layers (Registered User) > Right Click “Spatial Layers” > Add Layer > Select 

Layer Type > Select File 

 

Land Use Land Cover 

Select a dataset for land use land cover consistent with the USGS National Land Use Land Cover 

(NLCD) classifications. US National Datasets including NLCD 2001, NLCD 2006, and NLCD 2011 are 

availed for analysis within the US.  

For other regions, users must provide a raster class layer for land use land cover. To upload your 

own raster layer, you must be logged into your user account.  

• Layers can be uploaded under the “Map” tab (Fig. 3) > User Layers/Project Layers (Registered 

User) > “Spatial Layers” > Add Layer > Select Layer Type > Select File > Click “OK” 

Climate 

Several options for regions within the US are available and can be selected from US Datasets drop 

menu, including the PRISM and NARR datasets. For all other regions, the user must provide the data 

in two tables: 

(i) a metadata file table that provides information about  station ID, agency, latitude, 

longitude, and elevation of each station in the user datasets; and  

(ii) a separate table for each station in the metadata files 

 

To upload your own climate data: 

http://onewatersolutions.com/
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• Tables can be uploaded under the “Map” tab (Fig. 3) > User Layers/Project Layers (Registered 

User) > “Tables” > Add Table > Select File s> Click “OK” 

 

  

Figure 3: Selecting data (pictured left) and- adding files (pictured right). 

http://onewatersolutions.com/
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STEP 3 - CREATE SCENARIOS 

A default scenario is automatically created for the service area, which can be modified to simulate 

baseline water demand projections. Users can generate and manipulate new scenarios of alternative 

water management strategies or changes in climate, land use or population following the procedures 

below. 

Scenarios can include options for “Home Profiles”, “Landscape Irrigation Demand and Conservation”; 

“Graywater Reuse”; and “Stormwater Use”. The user can also modify the parameters for practices 

including: “Graywater Reuse”; “Stormwater Reuse”; “Wastewater Reuse”; and “Irrigation 

Conservation”.   Users can also generate “Projections” for changes in population and land use; and 

“Costs” associated with conservation and demand reduction practices. 

Create Scenarios 

Once you have defined the geographic area and selected the subunits and datasets you will be able 

to create, compile and run multiple scenarios to explore alternative water management strategies.  

Follow the simple steps below to begin building your scenario(s): 

1. Click “Edit” button to the right of the currently selected service area in the left dashboard 

(IUWM tab) 

2. Click “Create” to generate a new scenario and provide a meaningful title to easily compare 

the results (e.g. Graywater Reuse or Hot/Dry Climate) 

• Users can create multiple scenarios at once by simply following the steps below  

• Note - A “default” scenario is automatically created for the service area, which can be 

modified to simulate baseline water demand projections or left as-is. 

3. Select corresponding tab to manipulate inputs 

• To create another scenario simply click “Create” and repeat the process (i.e. you do 

not need to save each individual scenario) 

4. Once all desired scenarios are created, click “Save” 

5. After the scenarios have been saved, click the “Run” button to the right of the currently 

selected service area in left dashboard 

• Specify period of time to run the model (in years), then click “Run” in the dialogue 

box 

6. Once the run is complete, the results will be accessible in the panel at the bottom of your 

screen 

• Use the “Scenario” drop down menu to select one or more scenarios for visualization 

Parameters 

The parameters (Fig. 4) included in the IUWM are described below.  Each parameter is available to 

modify under the “Parameters” tab of the “Edit” dialogue box.  A description of the model 

assumptions and calculations used can be found in Sharvelle et al. 2017. 

http://onewatersolutions.com/
mailto:mowsi@colostate.edu
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Home Profile 

The Home Profile allows users to modify indoor conservation.  Under this category the percentage of 

older average homes (before 1999), average homes (2016) and high efficiency homes can be 

modified to simulate installation of high efficiency fixtures in the home.  

Commercial, Industrial and Institutional (CII) Use 

CII use can be modified based on indoor demand per household or ratio of indoor CCI use to 

residential indoor use. 

Landscape Irrigation 

Irrigation demand and conservation can be modified based on temperature driven decision-making 

as well as percentage of irrigated area. 

Graywater Reuse 

Graywater reuse can modified as a portion of faucet water that is not kitchen wastewater. 

Wastewater Reuse 

Wastewater reuse can be modified as the minimum percent blended with treated raw water supply. 

Stormwater Use 

Stormwater use can be modified as a percent of precipitation that turns into runoff. 

Costs 

Costs ($/1000gal) associated with the following treatment and reuse practices can be manipulated: 

• Water treatment  

• Wastewater treatment 

• Wastewater reuse  

• Stormwater treatment 

• Graywater treatment  

 

Practices 

The practices (Fig. 5) modeled in the IUWM are described below.  Users can modify each practice in 

the “Edit” dialogue box, under the “Practice” tab.  A description of the model assumptions and 

calculations used can be found in Sharvelle et al. 2017 

Graywater Reuse 

For each use of graywater, the user needs to specify percentage of population adopting (“% 

Adoption”) and “Storage Capacity per Household in Gallons”. Storage could be on a household basis, 

or centralized in a neighborhood or multi-residential building. Either way, storage is entered on a per 

household basis. 

http://onewatersolutions.com/
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Additionally, IUWM enables users to estimate the impact of graywater use for several end uses 

including: 

• Residential Flushing: Use of graywater to flush toilets in residences 

• Irrigation: Use of graywater for landscape irrigation 

• Combined Flushing and Irrigation: Use of graywater to both flush toilets in residences and 

irrigate landscape 

o Note: it is assumed that graywater will first be used to flush toilets, and excess is used 

for irrigation. 

• Residential Potable: Graywater is treated to potable quality and blended with municipal water 

to meet indoor water demand 

• Combined Potable and Irrigation: Some graywater is used to meet irrigation demand, while 

some graywater is treated to potable quality to supply water for indoor demand, and indoor 

demand is met first, with excess source water being used to meet irrigation demand 

• Commercial, Industrial and Institutional (CII): Graywater is used to meet demands for CII use. 

Treatment would vary based on the end use for water (e.g. irrigation, toilet flushing, cooling 

tower etc.) 

 

Stormwater Use 

IUWM enables users to estimate the impact of stormwater capture and use for several end uses. The 

end uses are the same as those defined above for Graywater Reuse:  

• Residential Flushing  

• Irrigation  

• Combined Flushing and Irrigation  

• Residential Potable  

• Combined Potable and Irrigation  

 

Wastewater Reuse 

The quantity of wastewater available for reuse is specified as a percentage of total wastewater. The 

user then selects an end use, which are the same as those defined above for Graywater Reuse: 

• Residential Flushing  

• Irrigation  

• Combined Flushing and Irrigation  

• Residential Potable  

• Combined Potable and Irrigation 

• Indoor Commercial, Industrial, and Institutional (CII) 

 

Irrigation Conservation 

There are several approaches by which irrigation conservation can be achieved. IUWM enables 

simulations of the following irrigation modifications: 

http://onewatersolutions.com/
mailto:mowsi@colostate.edu


Integrated Urban Water Model (IUWM) 

User Guide 

15 

 
onewatersolutions.com | Colorado State University | owsi@colostate.edu 

 

• Evapotranspiration (ET) demand met: Irrigators may have different behaviors for how much 

water is applied for irrigation. This is represented via the “Evaporation demand met” 

parameter where the user can adjust the percentage of evapotranspiration demand met. 

• Decrease in irrigation achieved via advanced irrigation systems: Advanced irrigation systems 

can be installed that include moisture sensors or rain gauges to ensure irrigation does not 

exceed plant requirements. This option allows the user to estimate a percentage decrease 

achieved via this practice. 

• Irrigation efficiency: All irrigation approaches have an irrigation efficiency associated with 

them. The “irrigation efficiency” option enables the user to modify efficiency of irrigation 

practices. The default value is 78%, which is a typical efficiency for sprinkler irrigation. 

• Percent of precipitation for which residents account when making an irrigation decision: 

Some irrigators turn off their irrigation systems when there is rain. This option enables the 

user to modify the percentage or rainfall that is decreased from the irrigation demand. 

• Plant Factor: This enables adjustment of irrigation demand based on type of landscape (e.g. 

xeriscape landscape). Plant factors are taken from SLIDE: Simplified Landscape Irrigation 

Demand Estimation 

 

Projections 

Changes in population, number of households or density of development can be simulated under 

“Projections”. Projections are input as a percent change from the baseline inputs for population and 

land use. 

 

Climate 

Users are able to change precipitation by a percentage and temperature by an increment (Fig. 6), or 

specify new climate files for the scenario (e.g., climate change scenarios). 

 

Subunits 

IUWM enables the user to manually change any attribute of interest for any subunit (Fig. 7).  Double-

click on a cell to make an edit. Any changes made to the subunit table during this session will cause 

changes in the other parts of the editor to be ignored. 

 

Observed Data 

Users can also upload a csv table that contains observed data, and it will be plotted with the model 

results. The format is the same as the model output table.  
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Figure 4: Parameters menu for modifying home profiles, 

landscape irrigation, graywater reuse and stormwater use. 
Figure 5: Practices menu for modifying graywater use, 

wastewater reuse, irrigation conservation, projections and 

costs. 

Figure 6: Climate menu to modify temperature and 

precipitation 
Figure 7: Subunit menu to modify any attribute of interest for 

any subunit. 
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STEP 4 - COMPARE & ANALYZE RESULTS 

IUWM has sophisticated graphing capabilities that allows the user to evaluate the impact of land use 

configurations, changes in climate, conservation programs and alternative water sources on water 

supply demands. The graphing tools can be tailored to the user’s needs and exported along with the 

raw data. 

For each subunit selected (e.g. block group) within the specified service area (i.e. boundary) IUWM 

will estimate the indoor and outdoor demand for potable municipal water associated with those 

areas and the inputs you have selected. 

The interactive web-map allows users to click on the individual subunits to view specific information 

about the area, including the modeled demand for the individual subunits.  This information can be 

viewed in both a dialogue box as well as in the histogram displayed in the bottom panel. 

 

  

Figure 8: IUWM subunit data display in visualization panel 

http://onewatersolutions.com/
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Visualization & Graphing 

The bottom panel provides several options for visualization of the model outputs for the entire 

service area, individual subunits, or a combination of selected subunits. Outputs can be summarized 

on an annual basis, monthly time step, or average monthly responses. 

 

After you have run your scenario(s) you can view one or multiple results in the visualization panel 

located at the bottom of the screen.  Using the drop down menus in the visualization panel users can 

customize the scenarios displayed and histograms properties (Fig 9).   

 

1. Create graphs by selecting the scenario(s) in the visualization panel at the bottom of the 

screen 

a. Users can modify the displays for subunits, time step, and demand 

b. Users can normalize the data by area or population 

c. Download resulting output as a figure (*.png, *.jpg, etc.) or as a table (CSV or Excel 

file) by clicking the horizontal lines in the upper right corner of the visualization panel 

(Fig. 9) 

• Results illustrate the demand for municipal potable water 

Note: Click your mouse over a subunit in your service area to display the results for 

that specific subunit (e.g. block group) 

 

 

Figure 9: IUWM graphing and visualization functions 

http://onewatersolutions.com/
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SCENARIOS OF USE 

IUWM allows users to generate multiple scenarios at once and run them simultaneously to efficiently 

and effectively compare the results of various practices and projections.  Listed below you will find 

some of the most common uses for the tool, with a brief tutorial for setting up the corresponding 

IUWM scenario. 

BASELINE WATER DEMAND 

A “default” scenario is automatically created for the selected service area, which can be modified to 

simulate baseline water demand projections or left as-is.  Users can customize the baseline 

(“default”) scenario by entering their own parameters, specific to their service area.  

Generate Baseline Scenario 

1. Follow the instructions outlined in Step 3 and make any necessary modifications to the 

“default” scenario in the “Edit” dialogue box, then click “Save”.   

2. Select “Run” from the left dashboard (IUWM tab) 

a. Provide a year range in the dialogue box 

b. Click “Run” in the dialogue box 

3. IUWM will now extract data and run the default model 

a. Once complete you can close the dialogue box 

Note: Alternatively users can run the default (“baseline”) scenario simultaneously with 

any other scenarios of interest 

4. Follow the steps outlined in Step 4 to create graphs and export results (Fig. 9) 

 

ALTERNATIVE WATER SOURCES, CONSERVATION & REUSE 

Figure 10: IUWM baseline (“default”) water demand graph (example) 

http://onewatersolutions.com/
mailto:mowsi@colostate.edu


Integrated Urban Water Model (IUWM) 

User Guide 

20 

 
onewatersolutions.com | Colorado State University | owsi@colostate.edu 

 

Adoption rates and water source supply availability parameters can be modified to simulate potential 

effects of the use of alternative water sources to meet indoor, outdoor and CII demands.  

Water Sources 

Alternative water sources include: treated raw water, reused graywater, reused wastewater and 

stormwater.  These sources can be used to meet the following potable and non-potable demands 

referred to as “reuse purposes”: 

• CII demand 

• Toilet flushing 

• All potable uses 

• Irrigation 

• Both toilet flushing and irrigation 

• Both potable and irrigation 

 

Conservation & Reuse 

IUWM can be also be used to inform decisions regarding water conservation and reuse strategies 

that encourage or incentivize consumers to utilize various practices.  Users can create scenarios for a 

variety of parameters and practices including: 

• Landscape Irrigation 

• Indoor conservation 

• Graywater reuse 

• Wastewater reuse 

• Stormwater use 

 

Generate Alternative Water Use, Reuse & Conservation Scenarios 

Following the instructions described in Step 3, users can incorporate use of alternative water sources 

by performing the following modifications under the PRACTICES tab: 

1. Follow the instructions outlined in Step 3 and create a new scenario with a meaningful title 

(e.g. Toilet Flushing and Irrigation) in the “Edit” dialogue box 

a. Be sure the new scenario is selected in the “Current Scenario” drop down menu to 

ensure changes are made to the correct scenario 

2. Modify any of the categories displayed to change adoption and/or storage capacity for 

various alternative water use strategies 

a. For example, you could create scenarios for: 

i. Graywater reuse for toilet flushing and irrigation 

ii. Stormwater use for toilet flushing and irrigation 

iii. Combinations of practices and sources 

3. Once you are satisfied with the modifications you can either  

a. Click “Save” to run the scenario OR 

http://onewatersolutions.com/
mailto:mowsi@colostate.edu


Integrated Urban Water Model (IUWM) 

User Guide 

21 

 
onewatersolutions.com | Colorado State University | owsi@colostate.edu 

 

b. Create a new scenario without exiting the “Edit” dialogue box, then run multiple 

scenarios at once 

4. Select “Run” from the left dashboard (IUWM tab) 

a. Provide a year range in the dialogue box, then Click “Run” 

5. IUWM will now extract data and run the model based on the parameters you have entered 

a. Once complete you can close the IUWM Model Run box 

6. Follow the instructions outlined in Step 4 to create graphs and export results (Fig. 9) 

 

 

 

  

Figure 11: Results for adoption of either graywater or stormwater reuse in toilet flushing and irrigation (example) 
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CLIMATE CHANGE & URBAN GROWTH 

These scenarios can be used to evaluate the impact of changing climate, population growth and land 

use change – all of which are critical factors in water demand planning and management. 

Climate 

Users can use the prepopulated (default) PRISM data or upload their own climate data.  User 

provided climate tables must include the following columns, in this order: id, date, tmin (degF), tmax 

(degF), and prcp (in). 

Population 

Users can create alternative levels of population growth and development.  Modifications can be 

made to any of the following categories: population, households, open space, low-medium-or high 

density area, and imperviousness. 

Generate Climate Change & Urban Growth Scenarios 

Following the instructions described in Step 3, users can create alternative future climate and growth 

scenarios by performing the following modifications: 

1. Follow the instructions outlined in Step 3 and create a new scenario with a meaningful title 

(e.g. Hot-Dry Climate or Urban Growth) in the “Edit” dialogue box 

a. Be sure the new scenario is selected in the “Current Scenario” drop down menu to 

ensure changes are made to the correct scenario 

2. Modify any of the categories displayed to for various alternative future scenarios: 

a. Climate inputs can be modified under the “Climate” tab of the “Edit” dialogue box 

i. Example: Hot-Dry Climate – increase the temperature offset, decrease the 

precipitation 

b. Population inputs are accessed from the “Practices” tab, under the “Projections” 

drop-down in the “Edit” dialogue box 

i. Example: High Density Urban Growth – increase population change, 

households, high density area and imperviousness change.  Decrease 

medium and low density area change. 

3. Once you are satisfied with the modifications you can either  

a. Click “Save” to run the scenario OR 

b. Create a new scenario without exiting the “Edit” dialogue box, then run multiple 

scenarios at once 

4. Select “Run” from the left dashboard (IUWM tab) 

a. Provide a year range in the call-out box, then Click “Run” 

5. IUWM will now extract data and run the model based on the parameters you have entered 

a. Once complete you can close the IUWM Model Run box 

6. Follow the instructions outlined in Step 4 to create graphs and export results (Fig. 9) 
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Figure 12: IUWM results for a hot-dry climate and urban growth (example) 
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GLOSSARY 

Census Tract: Census Tracts are small, relatively permanent statistical subdivisions of a county or 

equivalent entity that are updated by local participants prior to each decennial census as part of the 

Census Bureau’s Participant Statistical Areas Program.  The Census Bureau delineates census tracts in 

situations where no local participant existed or where state, local, or tribal governments declined to 

participate. The primary purpose of census tracts is to provide a stable set of geographic units for the 

presentation of statistical data. 

Census tracts generally have a population size between 1,200 and 8,000 people, with an optimum 

size of 4,000 people.  A census tract usually covers a contiguous area; however, the spatial size of 

census tracts varies widely depending on the density of settlement.  Census tract boundaries are 

delineated with the intention of being maintained over a long time so that statistical comparisons 

can be made from census to census.  Census tracts occasionally are split due to population growth or 

merged as a result of substantial population decline. For more information, click here. 

Census Block Group: Block Groups (BGs) are statistical divisions of census tracts, are generally 

defined to contain between 600 and 3,000 people, and are used to present data and control block 

numbering.  A block group consists of clusters of blocks within the same census tract that have the 

same first digit of their four-digit census block number.  For example, blocks 3001, 3002, 3003, . . ., 

3999 in census tract 1210.02 belong to BG 3 in that census tract.  Most BGs were delineated by local 

participants in the Census Bureau’s Participant Statistical Areas Program.  The Census Bureau 

delineated BGs only where a local or tribal government declined to participate, and a regional 

organization or State Data Center was not available to participate. 

A BG usually covers a contiguous area.  Each census tract contains at least one BG, and BGs are 

uniquely numbered within the census tract.  Within the standard census geographic hierarchy, BGs 

never cross state, county, or census tract boundaries but may cross the boundaries of any other 

geographic entity. For more information, click here. 

Census Block: Blocks are statistical areas bounded by visible features, such as streets, roads, streams, 

and railroad tracks, and by nonvisible boundaries, such as selected property lines and city, township, 

school district, and county limits and short line-of-sight extensions of streets and roads.  Generally, 

census blocks are small in area; for example, a block in a city bounded on all sides by streets. Census 

blocks in suburban and rural areas may be large, irregular, and bounded by a variety of features, 

such as roads, streams, and transmission lines. In remote areas, census blocks may encompass 

hundreds of square miles.   Census blocks cover the entire territory of the United States, Puerto Rico, 

and the Island Areas.  Census blocks nest within all other tabulated census geographic entities and 

are the basis for all tabulated data. For more information, click here. 

National Land Use Land Cover Dataset (NLCD): The National Land Cover Database (NLCD) Land 

Cover Collection is produced through a cooperative project conducted by the Multi-Resolution Land 

Characteristics (MRLC) Consortium (www.mrlc.gov). The MRLC Consortium is a partnership of Federal 

agencies, consisting of the U.S. Geological Survey, the National Oceanic and Atmospheric 
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Administration, the U.S. Environmental Protection Agency, the U.S. Department of Agriculture (USDA) 

National Agricultural Statistics Service, the U.S. Forest Service, the National Park Service, the U.S. Fish 

and Wildlife Service, the Bureau of Land Management, NASA, and the U.S. Army Corps of Engineers. 

A primary goal of the MRLC Consortium is to generate current, consistent, and seamless national 

datasets of land cover, percent developed imperviousness, and percent tree canopy. NLCD 2001 land 

cover was created by partitioning the conterminous United States into 66 mapping zones, based on 

ecoregion and geographical characteristics, edge matching features, and the size requirement of 

Landsat mosaics. NLCD 2001 represents a seamless assembly of land cover for all 66 MRLC mapping 

zones. NLCD 2001 land cover was developed for all 50 states and Puerto Rico / U.S. Virgin Islands. 

NLCD 2006 land cover was created on a path/row basis and mosaicked to create a seamless national 

product. NLCD 2006 land cover was developed for the conterminous United States. NLCD 2011 land 

cover was created on a path/row basis and mosaicked to create a seamless national product. The 

data in NLCD 2011 are completely integrated with NLCD 2001 and NLCD 2006. As part of the NLCD 

2011 project, the NLCD 2001 and 2006 land cover data products were revised and reissued to 

provide full compatibility with the new NLCD 2011 products. NLCD 2011 land cover was developed 

for the conterminous United States and Alaska. Questions about the NLCD Land Cover Collection can 

be directed to the NLCD land cover mapping team at USGS EROS, Sioux Falls, SD (605) 594-6151 or 

mrlc@usgs.gov. For more information, click here. 

PRISM Climate Date: PRISM datasets provide estimates of six basic climate elements: precipitation 

(ppt), minimum temperature (tmin), maximum temperature (tmax), dew point (tdmean), minimum 

vapor pressure deficit (vpdmin), and maximum  vapor pressure deficit (vpdmax).  Two derived 

variables, mean temperature (tmean) and vapor pressure (vpr), are sometimes included, depending 

on the dataset. For more information, click here. 

NARR Climate Data: The NARR project is an extension of the NCEP Global Reanalysis which is run 

over the North American Region. The NARR model uses the very high resolution NCEP Eta Model 

(32km/45 layer) together with the Regional Data Assimilation System (RDAS) which, significantly, 

assimilates precipitation along with other variables. The improvements in the model/assimilation 

have resulted in a dataset with substantial improvements in the accuracy of temperature, winds and 

precipitation compared to the NCEP-DOE Global Reanalysis 2. We currently have output which 

includes 8 times daily data at 29 levels and most of the variables. For  more information, click here. 
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